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EnvisionProject Layout  

EnvisionProject 2.0 now has three tabs on the Main Editor window. The three tabs are  

•  Logical view 

•  Network view  

• Physical view 

Physical View tab is the new tab in EnvisionProject 2.0. 

Physical View  
The Physical view represents the physical location and physical channels of devices in the Philips 
Dynalite system. The Physical tree displays the floor plans and devices defined for the current 
job. A graphical plan is available for every floor plan in the physical view. Background Images are 
displayed in the floor plan window by double clicking on the plan in the physical view. 

 

Physical View Tree 
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Menu bar Icons 

 

 Add Plan   

Adds a new plan to the tree structure of the physical view.  

 Add Folder  

Adds a new folder in the physical view. Folders can be used to group plans or devices in the 
physical view. 

 Add Distribution Board  

Adds a Distribution Board to the plan. The controllers on the plan can be placed under a 
Distribution Board. Distribution Boards can then be added as icons on the graphical floor plan. 

Delete  

Deletes the selected item in the Physical view tree 

Insert Device 

 Inserts new devices in the Physical view 

Insert Device from network  

Enables you to search, sign-on and load devices and information from the network 

 Show/Hide columns 

Displays a drop-down list that is used to select the fields that are displayed as columns on the 
Physical view  

Find device in tree 

Search for devices in the Physical view by name or serial number 

Run device List Report  

Produces a device configuration report for the device selected in the Physical view 

Show Floor Plan 

Displays the graphical floor plan in the Floor Plan window for the selected floor in Physical view 
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Auto Flash 

 Automatically flashes the selected physical channel. Use the Control key and up/down arrow 
keys to select the unassigned physical channel. The selected channel starts to flash. This can be 
used to quickly locate each physical channel on the floor. 
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Managing Plans, Folders and Devices 
New plans, folders and devices can be used to:  

• Insert- using either the tool-strip buttons at the top of the physical view, the context 
menu or from the main window Insert menu.  

• Cut, copy or paste – using either the context menu or the main window Edit menu 
or toolbar.  

• Delete or rename – using either the context menu or the main window Edit menu or 
toolbar.  

• Move or copy – by dragging around the physical tree.  

• Add and Manage devices– by dragging and dropping devices from the device palette 
on to the floor plan. 
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Plan Properties 
The plan properties are displayed in the Properties Window when a plan is selected in the 
Physical View. A Plan in Physical view has the following properties. 

 

Plan Properties 

General  

Name 
Name given to the floor plan. 

Title 
Title shown on the Floor Plan window for the plan selected. 

Notes 
Small section for notes that can be used to write about the floor plan. 

Default bridge 
Each plan can have a default bridge. The default bridge is indicated in the physical view with a 
small tick on the top left of the icon.  
The first bridge added to the plan is automatically set as the default bridge. The default bridge 
can be changed by right clicking on the new bridge or under the Plan properties in the 
Properties Window. 

When devices are added to the plan they will be automatically added under the default bridge in 
the network view.  

Scale Factor 
Icons on the floor plan can be scaled using the scaling factor. This factor is set when new icons 
are added to the plan. The scaling factor is automatically set when an icon is proportionally 
scaled in the plan. 
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Background  

Image name 
Name of the background image uploaded as floor plan. 

Image Opacity 
Sets the opacity (transparency) of the background image. 

Background Color 
Sets the background color for the image. Select the background color by clicking on the drop-
down list. 

Size 

Width and Height  
The width and height (plan size) is automatically adjusted to the size of the background image 
when the background is inserted. The width and height of the background image can only be 
reduced to size that can fit the icons and the regions on the plan.  
The size and position of the background images can be modified using the Edit Background 
Image option on the Floor Plan Window. Right-click on the background image to exit the edit 
mode. 
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Floor Plan Window 
The Floor Plan Window is available from the Logical view, Network view and the Physical view. 

The Floor Plan window is displayed on the right in the Main window. You can also open the 
Floor Plan Window in a separate window by clicking Float Floor Plan Window from the 

Window menu or by clicking  icon the tool bar.  
Click  icon on the toolbar to view the floor plan window in the main window of 
EnvisionProject. 

 

Floor Plan Window 
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The Floor Plan Window consists of the following tool bar icons: 

 

 

 Pointer Mode  

The pointer mode is used to select the different items on the floor plan window. It can also be 
used to move device and fixture icons. 

 PanMode  

The Pan Mode pointer appears like a hand and is used to view the floor plan by dragging it 
around with the mouse.  

 ZoomMode  

ZoomMode is used to zoom-in or zoom-out a section on the floor plan. Click the ZoomMode 
and select the area to magnify. The mouse wheel can be used to zoom-in and out on the floor 
plan. Additionally the slider on the floor plan window can be used to zoom. 

 Lock Canvas  

Lock Canvas prevents from making further changes to the floor plan. In Lock Canvas mode the 
floor plan can only be viewed. All the editing features are locked so that no further changes can 
be made to the floor plan. 

 Bookmark Current Position  

The current position on the floor plan is bookmarked or saved using Bookmark Current 
Position. When you click Bookmark Current Position a bookmark is added under the bookmark 
folder in the Physical view tree. You can then name the bookmark you created. When a 
bookmark is saved the zoom level of the book marked position is also saved. 

 Show/Hide layers  

The Show/Hide layers can be used to view the floor plan according to the various objects that 
are present on the floor plan. The following are the available objects that can be selected while 
viewing the floor plan with Show/Hide layers. You can select the Select All option from the 
menu to turn ON/OFF all Devices/Region/Lines. 

Devices 

• The devices that can be placed on the floor plan include: 

• Load Controllers 
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• User Interfaces 

• Sensors 

• Gateways 

• Time-clocks  

Regions 

The following type of regions can be created on the floor plan in the physical view: 

• Area Region 

• BLA Region 

• Join region 

For more details see the section on Regions. 

Lines 

Lines can be drawn on the floor plan to depict connection between two or more devices or 
fixtures or devices. The types of lines that can be drawn on a floor plan are: 

• Fixture Group Lines 

• Fixture Control Lines 

• DyNet Lines 

• DALI Control Lines 

• DALI Cable Lines 

For more details see the section on Lines. 

Distribution Board 

The controllers on the floor plan are placed in the Distribution Board. The distribution boards 
are placed under the Distribution Board folder in the tree structure of the physical view. 

Fixtures are electrical devices that are placed on the floor plan. This option show or hides all 
the fixtures that are placed on the floor plan 
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Background 

Background is the actual floor plan on which devices are placed.  

 Show/Hide Icon Status  

Shows the current status of icons placed on the floor plan. For more details on Status of 
Devices, Fixtures, Distribution Boards refer to the section Status Indicators  

 Request Levels  

Displays the current active levels of the icons placed on the floor plan. You can request current 
levels for the selected icons or for the whole plan. 

 Draw Rectangular Area  

A floor plan can be divided into different areas while commissioning a site. This icon is used to 
mark rectangular shaped areas on the floor plan. Three different types of areas can be drawn 
using the Draw Rectangular Area tool. 

• Draw Area  

• Draw Base Area  

• Draw Join  

For more information on how to draw areas see the section Drawing Area Regions. 

 Draw Polygon Area  

Draw Polygon can be used to mark polygon shaped areas on the floor plan. 

For more information on how to draw areas see the section Drawing Area Regions.  

 Draw Line  

Draw lines can be used to draw a connection between devices. The following types of lines can 
be drawn using the draw line tool. 

•  Draw Fixture Group  

•  Draw Dynet Cable  

•  Draw DALI Cable  

 



15  
EnvisionProject2.0 New Features Guide 

Note – The Curved lines option can be checked to draw curved lines. 

For more information on lines, see the section Lines 

Create Text  

Create text can be used to add text to the floor plan window. Select Create Text, drag and 
draw text boxes. Text can be typed into the drawn text boxes. 

Background Image  

A floor plan can be inserted into the floor plan window using the Background Image icon. You 
can select, replace, edit, and clear floor plans using the Background Image menu. Right-click on 
the background image to exit edit mode. 

Smart Snap  

Smart Snap is an auto alignment feature. When adding or moving icons and regions in the floor 
plan, smart snap will snap its alignment to the icons or regions around it. The blue lines that 
appear around the icon are the smart snap line 

 Show and Snap to Gridlines  

Displays gridlines on the floor plan. When adding or moving icons and regions on the floor plan, 
snap to gridlines will snap the icons and regions to the grid lines. The distance between grid lines 
can be changed in the EnvisionProject -Settings Window under the Tools menu. 

Split Windows 
Use Split Windows to view both configuration window and the floor plan window together on 
the main window.  

Split windows 

1. Click the Window menu and click Split Windows or click on the toolbar. 

2. Use the Split windows menu to split the Configuration window and Floor plan window 
in the following ways: 

• Spilt Horizontally 

• Split Vertically 

• Split Horizontally with auto-hide 

• Split vertically with auto-hide  
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Navigating the Floor Plan Window 
Mini Map 

Mini Map is a miniature version of the floor plan. A floor plan is inserted as the background 
image of a floor plan window. Click  on the floor plan window to insert a background image. 

Click  to view the mini map. The blue rectangle can be moved around in the Mini map to view 
a large image of the rectangular section on the floor plan window. The highlighted section in the 
graphic below shows the Mini Map for the inserted floor plan. 

 

Mini Map 

Mouse Shortcuts  
• Use the middle mouse wheel to zoom on the floor plan  

• Use ‘+” and ‘-‘ keys to Zoom 

• Use Ctrl + ‘0’ to zoom out to show the whole Floor Plan 

• Ctrl + ‘1’ will zoom to a normal zoom level 

• Hold-down the middle mouse button to Pan 
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• Use Alt and the left mouse button to Pan 

Keyboard Shortcuts 
The following key-board shortcuts can be used for navigation on the floor plan window 

• F9 to toggle between Floor Plan Window and Properties Window 

• Press Arrow Keys to move icons by a pixel 

• Press Ctrl + Arrow Keys to move icons by 10 pixels 

• Press Arrow Keys to move the background image by a pixel (in Edit or Replace 
Background Image Mode) 

• Press Ctrl + Arrow Keys to move background image by  
10 pixels (in Edit or Replace Background Image Mode) 

• Hold down the shift key while rotating an icon to align the icon to a 45° angle 
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Floor plan in Network View  
The Network View supports the following modifications on the floor plan window. 

Devices from the Network view can be, 

• Added to the floor plan directly, by dragging the device and placing it on the floor plan. 

• Located on the Floor Plan Window using the Find Device Icon from the context 
menu in the Network View. A window is displayed listing the plans on which the 
device can be found. If the device only exists on the current plan then it will 
automatically be selected and displayed in the Floor Plan Window. 

Floor Plan in Logical View  
The Logical view supports the following modifications on the floor plan window. 

• Areas and regions can be added to the plan directly from the Logical View by dragging 
the area and placing it on the floor plan. On the floor plan either a rectangular or 
polygon region will be created depending upon the last type of region created. 

• If a logical Area is dragged from the Logical View onto an existing Area region on the 
floor plan then the logical area will be changed as the existing Area on the floor plan.  

• Physical channels from the Logical View tab or Unassigned Devices tab on the 
Configuration Window can be dragged and placed on the floor plan. 

• Areas in the Logical View can be located on the Floor Plan Window using the Find 
Area Region from the context menu in the Logical view. A window is displayed listing 
the plans on which the area can be found. If the area exists only on the current plan 
then it will automatically be selected and displayed in the Floor Plan Window. 

• Auto-light sensor calibration is available for one or more selected Areas from the 
context menu in the Logical View. Each light sensor in the Area measures the light level 
when lights are OFF and when lights are ON and use the difference to calculate the 
Setpoint. 
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Area Regions 
Drawing Area Regions on the Floor Plan 

Draw an area region 

1. Select  or  from the menu bar on the Floor Plan window. Drag and draw the 
mouse pointer on the floor plan to draw an area. After the area is drawn, the Area 
Selection dialog box is displayed.  

 

Area Selection pop-up 

2. On the Area Selection dialog box, Enter the Name of the Area and Click OK. 

Note – Use Draw Rectangular Area to draw square or rectangular shaped areas. 

 Use Draw Polygon Area to draw polygonal shaped areas. 

Draw area regions with Curved Lines, 

1. Draw a basic shape (rectangle or polygon) on the floor map. 

2. Right-click on the drawn shape and select Edit Region from the context menu. The 
anchor points on the region appear. 

3. Select the line segment that you want to be changed to a curve. Right-click on the line 
and select Make a Curved line. An Anchor point is added. 

4. Move the anchor point accordingly to draw a curved line. 
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Types of Regions 
The following are the type of areas that can be created on a floor plan. 

• Draw Area Region– Area that combines one or more channels 

• Draw BLA Region – Area that combines one or more areas. It can be used to group 
areas. The areas that are grouped can be controlled as a single area. 

• Draw Join Region – Area that is created to divide an area into two or more areas. 
The area that is divided behaves as different areas. 

Editing Regions  
To edit an area, right-click on the area, select Edit Region and right-click again. 

The following context menu is displayed, 

 

Edit Context Menu 

Right-click on any line segment in the area region and select, 

• Make Line Curved –to draw a curved line 

• Make Line Straight –to make a line segment straight 

• Add Anchor Point – to add an anchor point and extend the area region 

• Delete Anchor Point – to delete an anchor point 

• Create Exclusion – to create irregular shaped regions with cut out sections 

• Scale – to scale the entire area region 

• Rotate - to rotate the area region. 

Other Actions that can be performed on Regions 
Right-click on a drawn area region to open the following context menu. 
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Area Context Menu 

• Start Flashing – Flashes the selected area. 

• Change area – Opens the Area Selection Window to change the logical area 
assignment. 

• Edit Area – Edit the selected area. Refer to Editing regions for more information. 

• Move Region – The selected region can be moved to different location on the floor 
plan. This includes moving all the icons (fixtures, devices) in the selected region. 

• Scale – The selected area can be increased or decreased in size to fit a desired region. 

• Rotate – An area can be rotated in any direction by rotating the anchor points in the 
desired direction 

• Send To Back- Send the selected object of the floor plan to a layer behind the current 
one. 

• Bring to Front- Brings the selected object of the floor plan to the front layer of the 
plan 

• Cut - Cuts the selected region. If a region is cut then the area number will be 
maintained otherwise the user will be prompted to select the area number on paste 

• Copy - copies the size and shape of the selection region(s) only (that is, not any device 
or fixture icons in the region or any internal join regions).  
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• Paste- Pastes the selected area region. 

• Remove Region – Deletes the area region. 
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Lines 
Different types of lines can be drawn on the floor plan using the  Draw Line item on the 
Floor Plan window toolbar. 

 Fixture Group Line  
Allows you to draw lines between fixture icons and group them into a single circuit. 

Fixture groups can be extended to other fixtures or other fixture group as long as one of the 
two, being connected is currently unassigned or they both have the same assignment of load 
control.  

A Fixture group can only be extended to fixtures with fixture profiles of the same type.  

Fixtures assigned to DALI controllers cannot be added to fixture groups. 

 DyNet Cable Line  
DyNet cable lines can be drawn between DyNet devices to indicate the route of the DyNet 
cable  

 DALI Cable Line 
DALI cable line can be drawn between DALI ballast fixtures and DALI controllers to indicate 
the route of the DALI cable. It can also be drawn between DALI MultiMaster and DALI devices. 

Fixture Control Lines 
These lines shows the fixtures that are controlled by a selected controller 

DALI Control Lines 
These lines show the DALI devices controlled by a selected DALI controllers. 

Editing Lines 
The path of Fixture Group Lines and DyNet cable lines and DALI cable lines can be edited. 
Once a line has been selected for editing the following options are available. 

Use the below options to edit the line. 

• Add anchor point  

• Remove anchor point  

• Make Line Curved 

• Make Line Straight 
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• Delete Segment  

The whole line can be removed using Remove Line.  
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Device Palette 
The Floor Plan window contains a Device Palette window. Devices such as load controllers, 
user interfaces, sensors, time-clocks and gateways can be easily inserted on to the floor plan 
using the Device Palette window.  

 

Device Palette Window 

Add a device to the floor plan 

• Select the device from the device palette and place it as required on the floor plan. 
Right-click to stop adding devices.  

If a device you want to add is not present in the Device Palette window follow the below steps 
to add a device to the Device Palette window.  

Adding a device to the Device Palette 
1. Click  on the Device Palette window, to open the EnvisionProject - Create New 

Device Window. 

 

Create New Device Window 

2. Select the device from the list displayed and click OK. 
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A range of devices such as load controllers, user interfaces, sensors, dry-contacts, time-clocks 
and gateways can be inserted by selecting the required device from the various tabs available on 
the Create New Device window. 
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Fixture Palette  
The Floor plan window contains a Fixture Palette window, which is used to insert fixtures on to 
the floor plan. 

 

Fixture Palette 

Add a fixture to a floor plan 

• Select the fixture and place it on the floor plan. Right-click to stop adding fixtures. 

If a fixture you want to add is not present in the Device Palette window follow the below steps 
to add a device to the Fixture Palette window. 

Adding fixtures to the Fixture Palette 
1. Click  on the Fixture Palette window. The Fixture Profile Editor Window is displayed. 

From the fixture profile editor new user defined fixture profiles can be added or existing 
profiles can be duplicated. 

2. Select any of the available fixtures and click OK. 
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Adding new fixtures  
Customised fixtures can be added to the Fixture Profile Editor. 

 

Fixture Profile Editor 

1. Click  Add on the Fixture Profile Editor window 

2. Enter the respective fixture properties.  

Fixture Properties include: 

• Name 
Specifies the name of the fixture. 

• Description  
Description of the fixture 

• Manufacturer  
Details of the manufacturer 

• Fixture Image  
New image for the fixture can be uploaded here. 

• Fixture Type 
Specifies the type of the fixture. Type of the fixture can be Standard, Warm White 
Cool-White, Red-Green-Blue and Custom 

User defined fixture profiles including the fixture profile images are stored in the job file. The 
image supplied for user defined fixture profiles must have a transparent centre in order for the 
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current level to be shown. It only has to be partially transparent but must be surrounded by a 
completely solid border that defines the extent of the current level shading. 

For custom fixture profile types, you need to enter the Number of physical channels that 
can be assigned to the fixture and if these channels should be assigned to a single or separate 
logical channel. 

To delete a fixture profile, select the profile and click Delete. Fixture profiles can only be 
modified or deleted if they are not currently in use. 

To see the number of times that a fixture profile is used in the current job the select Show 
Usage 

To replace the use of a fixture profile, use Replace. Replacements can be done for all plans or 
specific plans. 

One or more selected fixture profiles can be exported to an external file and then re-imported 
into another job. The fixture profile images are included in the export file.  

Grouping Fixtures 
The fixtures that are placed on the Floor Plan Window can be grouped into channels in the 
following ways: 

• Using Draw Fixtures Group from the Draw Line toolbar icon on the Floor Plan 
Window 

• Selecting multiple fixtures, right-clicking on one of the fixtures and selecting Group 
Fixtures from the context menu. 

Context Menu Items for Fixtures, Devices and 
Distribution Boards 
Common: 

Scale – Scaling is done proportionally when scale from the corners 

Rotate - Rotates the selected icon (Fixture, Device, Distribution Board) in the desired 
direction. 

Save /  Reset Current Icon Size and Rotation - The current size and rotation of the 
selected icon will be saved, and used for newly added icons. It is reset when changing to a new 
plan. 
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Send to back / Bring to front – Moves the selected icon to the back or front to the 
front of the current layer of the floor plan. 

Remove Icon – Removes the icon from the plan only. Device’s and distribution boards will 
still exist in the physical view tree.  

Cut / Copy and Paste fixtures – The size, rotation and profile of the selected 
fixtures icons can be cut, copied and pasted. If a fixture icon is cut then the load control 
assignment will be maintained. Fixture group lines is also be copied. 

Cut / Copy and Paste devices - The size, rotation and type of the selected device 
icons can be cut, copied and pasted. If the device is copied then a new device will be created on 
paste. If the device is cut then the device icon will reference the original device. 

Devices: 
 Flashing – Flash the selected device 

 Save Modified Device Data – Save modified device data to the selected devices 

 Sign-on Device – Send a sign-on message to the selected devices 

 Edit Properties – To modify Name, Location, Description, Serial,  

Configure By Location – If this is set to false then the location of the devices icon will no 
longer update the logical assignment of the device. By default this is set to true.  

 Delete Device – Delete the device from the job 

Fixtures: 
 Flashing – Flash all physical channels assigned to the selected fixtures. 

 Save Modified Device Data – Save modified device data of the load controllers that are 
assigned to the selected fixtures 

 Edit Properties – Name, Location, Fixture Profile,  

Configure By Location - If this is set to false then the location of the fixture icon will no 
longer update the logical assignment of the physical channels. By default this is set to true. 

 Group Fixtures – Used to group fixture icons into a single circuit. A fixture group line will 
be automatically drawn between the fixtures. See details on Fixture Group Lines 

 Ungroup Fixture(s) – Used to ungroup one or more fixture icons from a fixture group 
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 Set Master Icon - The master icon is the icon that determines the channel configuration 
for a fixture group by its location. Master icons are indicated by a purple dot in the centre of the 
fixture icon.  

 Alignment - When multiple icons (or 
regions) are selection then the following alignment operations are available: align top, align 
bottom, align left, align right, align angle, center vertical, center horizontal, spread vertical, 
spread horizontal 
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Assigning Load Control to Fixtures 
Assigning Load Control to the existing fixtures icons on the floor plan 

If the fixture icons have already been placed on plan then the load control can be assigned to a 
fixture icon in the following way 

• Drag the physical channel from the load controller onto an existing fixture icon on the 

plan. The cursor changes to green circular arrow to indicate that the load control is 
to be assigned. 

• Once the fixture has been assigned a load control, the center of the fixture icon changes 
from white (no load control) to blue colour (load control with current level unknown) 

Assigning Load Control to fixtures when fixture icons are not present on 
the floor plan 

If the fixture icons are not present on the floor plan, then assign load control as below: 

• The physical channel from the load controller is dragged from the physical view onto 

the plan, this creates a new fixture icon and the physical channel is assigned to the 
fixture icon. The fixture icon created will be the one that is currently selected in the 
Fixture Profile Palette. 

• If multiple physical channels are dragged then multiple fixture icons are created. 

Multi-channel Fixtures 
Fixtures such as dimming ballast, RGB fixture, WWCW fixture that have to be assigned to 
multiple channels are called multi-channel fixtures. 

Assigning and modifying Load Control for Multi-Channel Fixtures 
When you drag the physical channel from the Physical view on to the multichannel fixture icon, 
Fixture Load Control dialog box is displayed.  

On the Fixture Load Control Window, the user is prompted to select the channels for the 
multi-channel fixture. The user selects the channel and clicks OK. 
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Modify the Load Control for multi-channel fixtures 
Right-click on the multi-channel fixture and select Modify Load Control from the context menu. 
The Fixture Load Control menu is displayed. Modify the channel assignment and click OK. 

The following fixture profiles support having multiple physical channels assigned to each fixture 
icon 

• Dimming Ballast – Switching and Dimming channels 

• RGB – Red, Green and Blue channels 

• WWCW – Warm-White and Cool-White channels 

• Custom – User defined number of channels 

Remove Load Control from fixture 
Right-click on the fixture and select Remove Load Control from the context menu displayed. 

Logical Channel Assignment 
Logical channels are assigned to the fixtures after they have been assigned to a physical channel. 

Right click on the fixture that has been assigned a physical channel and select Logical Channel 
Assignment.  The Logical Channel Selection Window is displayed. 

Select the logical channel for the fixture and click OK. 

You can also add, delete, rename, and move the logical channels up and down in the tree from 
the Logical Channel Selection Window. 

Note -The Status column next to each physical channel in the Physical View can display an Area 
icon or a fixture icon. The Area icon indicates if a physical channel has been assigned to an Area. 
The Fixture icon indicates if the physical channel has been assigned to a fixture icon on a plan. 
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Fixture Current Levels  
The current level of fixtures on the plan can be set by double-clicking the fixtures.  

It is only possible to change the current level of a fixture that has been assigned to a load 
control physical channel with an assigned box number. 

Depending upon the fixture profile and the channels assigned the fixture displays one of the 
following level controls  

• Relay – On and Off 

• Fan – High, Medium, Low, Off 

• Dimmable – Slider between 0 and 100% (the slider can be controlled using the middle 
mouse button, double clicking will toggle between 0%, 100% and current position) 

• RGB – Red, Green and Blue colour picker 

• WWCW – Warm-White and Cool-White dual slider 

Colour Indicators for Current levels in Fixtures 
The current level of fixtures will be indicated on fixture icons by the colour at the center of the 
icon.  

For standard fixtures, colour of the current level varies from dark grey (0%) to bright yellow 
(100%).  

For RGB fixtures, the current colour is shown. 

For Warm White Cool White fixtures (WWCW) colour representing the current temperature 
and intensity. 

A White center indicates that the fixture is unassigned to a physical channel. 

A Blue center indicates that the current level for the fixture is not yet known. 

A Purple dot at the center of the fixture indicates the master fixture icon in a fixture group. 

The current level for all fixtures on a plan or selected fixtures on a plan can be known by using 
the Request Levels button on the Floor Plan toolbar. 

Note - The current level is remembered for each fixture and is updated when DyNet message 
changes the level. By default these current levels is saved in the job file however when a job is 
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opened a brown dot will be shown on the fixture icon to indicate that the fixture level may be 
no longer valid (stale) 

Status Indicators 
The status of devices, fixtures and distribution boards are indicated with small coloured dots 
under the respective icons on the floor plan. 

Device Status  
The following are the status indicators for devices: 

Status Icon Status Icon Colour Device flashes Red / Orange / Blue / Green when - 

 Flashing Red 

There is an Error (Bootloader running, Logical or Physical translation 
error, Box number conflict) 

The logical address of the device doesn’t match the current logical 
region on which the icon is located (and Configure by Location is set 
to true) 

 Flashing Orange 
Device is Offline 

Device has an unassigned box number 

 Blue 
The Device has unsaved changes (flashes 3 times when a configuration 
change is made) 

 Flashing Green The device is currently communicating 
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Fixture Status 
The table below describes the various status indicators and the conditions at which these 
coloured icons appear below the fixtures: 

Status Icon Status Icon Colour  Fixture flashes Red / Orange / Blue when the - 

 Flashing Red 

DALI Emergency Test Result Fails 

DALI Ballast Fails 

Logical address of the assigned physical channels doesn’t match the 
current logical region on which the icon is located (and Configure by 
Location is set to true) 

 Flashing Orange 

Load Control is not assigned for the fixture 

Controller is Offline 

DALI Ballast is Offline 

 Blue Configuration change is made to the assigned physical channel. 

 

Distribution Board Status 
The status indicators for distribution boards represent the status of all the devices placed under 
the distribution board.  
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Copy Special 
The copy special option in the context menu, allows the user to select the items to copy. The 
following options are available under Copy Special for regions, fixtures and devices: 

Regions 
Maintain Region Numbers  
Pasted regions will have the same area or BLA numbers. 

Include Internal Regions  
Any region inside selected regions will also be copied. This includes Area regions inside BLA 
regions and Join regions inside Area regions. 

Include all Regions of selected Devices / Fixtures  
Any region that has the selected device or fixture icon located, will also be copied. This allows 
users to copy a large section of the floor plan. 

Fixture 
Maintain Load Control 
The physical channel assignment of all selected fixtures will be maintained. 

Devices 
Create New Devices  
Create new devices with unassigned box numbers. 

Duplicate Device Icon  
Create new device icons that point to the existing device. 
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Duplicate Plan 
Duplicate plan allows users to duplicate the entire floor plan. This feature can be used to 
commission floors that are similar or identical. 

To duplicate a plan, 

Open the Physical view tree, Right-click on an existing floor plan and select Duplicate plan. 
Duplicate Plan dialog box is displayed. 

  

Duplicate Plan Dialog box 

On the Duplicate Plan Dialog box, 

1. Enter the name of the duplicated plan at New Plan name field. 

2. Check the items that you want to include in the duplicate plan under the Select Items to 
Duplicate group. 

• Background – Size and background image, position, colour and opacity 
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• Bookmarks – The saved bookmarks in the plan 

• Text – Text in the plan 

• Fixtures- Fixtures that are placed on the floor plan 

• Regions Area Numbers – Created regions can be either unassigned or translated 
using any replacement bridges defined. If using translated then any new logical areas 
will also be created to match the existing area. 

• Devices – Created device box numbers will either be unassigned or translated using 
any replacement bridges defined 

• Maintain fixture load control – If devices and fixtures are selected then the load 
control can be maintained 

• DyNet cables lines – DyNet cable lines that are marked on the floor plan 

• DALI cables – DALI cable lines that are marked on the floor plan. 

3. Bridge Translations group allows users to select the replacement bridges for a new 
floor. These replacement bridges need to be created before performing a duplicate 
floor. 

4. Click OK to create a Duplicate plan.  
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User Settings 
The Floor Plan settings are configured on the EnvisionProject-Settings window. Navigate to 
Tools>Settings> Floor Plan to change the floor plan settings. 

Floor Plan 
Behavior 

Use software rendering 
Best performance is when using hardware rendering for the Floor Plan. Software rendering is 
only recommended for machines that have issues using hardware rendering. Check the 
checkbox to use software rendering. 

Show tooltips 
Turns the displaying tooltip on or off 

Request current preset from tooltip 
Check to request current preset of devices or fixtures from the tooltip. 

Request current logical levels from tooltip 
Check to request current logical levels of devices or fixtures from the tooltip. 

Regions 

Area border color  
Color of the border for Area regions. 

Base Area border color 
Color of the border for Base Area regions. 

Join border 
Color of the border for Join regions. 

Unassigned region color  
Color of the unassigned region. 

Lines 

Grid line distance (pixels) 
Distance in pixels between grid lines. 

Grid line color 
Sets the color of grid lines. 

Fixture group line color 
Sets the color of fixture group lines. 
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DyNet cable line color 
Sets the color of DyNet cable lines. 

DALI cable line color 
Sets the color of DALI cable lines. 

Fixture control line color 
Sets the color of fixture control lines. 

DALI control line color 
Sets the color of DALI control lines. 

Show fixture control lines when selected 
When the fixture control line layer is turned on then fixture control lines can either be shown 
for all fixtures or only for the selected controller or fixture. 

Show DALI Control lines when selected 
 When the DALI control line layer is turned on then DALI control lines can either be shown for 
all DALI devices or only for the selected DALI devices. 

Zoom 

Steps  
Number of zoom steps. 

Max Zoom  
The maximum zoom level for the Floor Plan. 

Auto Calibration 
 

Raw level max deviation (%) 
This parameter is used to determine the "end" of the transient response after a rapid change of 
the light level. Set to 1% by default.  

Calibration timeout (min)  
The minimum time delay between the calibration of two consecutive areas. 

Area Cascading  
 

Occupied Preset  
Default Preset of the parent area in the occupied state. 

Unoccupied Preset 
Default Preset value of the parent area in unoccupied state. 
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Standby Preset 
Standby preset is the preset that is sent an Area after Standby timeout. 

Occupation timeout 
Occupation time out is the amount of time each Area waits before it recalls the Standby preset. 

Standby timeout 
The amount of time that each area waits before it recalls the unoccupied preset. 

Fade Time 
Fade time is used as the default fade for area cascading object. It is used for standby fade, 
unoccupied fade and occupied fade. 

Heartbeat timer  
Heartbeat time is the time interval between the child areas sending a notification message to the 
parent area.  
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Pre-commissioning Process  
The pre-commissioning process for a site in EnvisionProject 2.0 can be completed by performing 
the below steps: 

1. Add a new floor plan in the Physical view for each floor in a building 

Click  on the menu bar in the Physical View, a new plan icon is displayed on the Physical 
View tree or Right-click on the job name and select New Plan from the context menu. 

2. Add Background Image to the plan 

For every plan in the building insert a background image  

To insert a Background Image, 

• Select the Plan icon in the tree view. 
Select the Window menu > Floor Plan Window. 

• Select  from the toolbar on the Floor Plan Window and click Select Background 
Image from the context menu displayed. 

 

Select Background Image 

• Browse to the image and click open to insert the image. 
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The background image is inserted on to the Floor Plan window. 

Note – Store the floor plan as a background image in a folder on your computer. 

3. Add lamp icons from the fixture palette to the floor plan 

Select the required fixture from the Fixture Palette Window and place it as required on the 
floor plan. Group your fixtures into different channels. When you hover your mouse over the 
fixture a pop-up appears displaying the fixture details. 

4. Draw Area regions on the floor plan. 

Click   Rectangular Area or  Polygon Area on the toolbar of the Floor Plan Window 
to draw areas on the floor plan. Three types of areas can be drawn on the floor plans - Normal 
area, Base area and Join Area. 

5. Add User interfaces to the floor plan 

Select User interfaces from the Create Device tab on the Properties Window or by selecting 
the User interface from the device palette window. Place the selected user interface as required 
on the floor plan. When you hover your mouse over the user interface a pop-up appears 
displaying the user interface details. 

6. Add Distribution Board to the floor plan 

Click  Add Distribution Board from the menu bar icons on the Physical View to add a 
distribution board to the plan. 

Controllers that are added can be placed under the Distribution Board folders. A Distribution 
Board is a point on the network that can contain all the controllers for the floor plan.  

Drag each controller device from the network tree into the distribution board icon on the plan. 
The controllers are placed under the Distribution Board folder in the physical view. 

7. Save the project.  
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Connect to the Network 
1. Load network 

Connect the Physical network to DyNet. 

2. Search  the network for devices or add devices from the Device Palette Window 

If the devices are present on the network, they are added to the tree in Network View. 

If the devices are not on the network you can add the devices on to the floor plan by selecting 
devices from the Device palette, and placing the selected device as required on the floor plan. 
When you hover over your mouse on the device a pop-up displaying the device details appear. 

3. Drag each controller device from the network tree into the distribution board icon on the floor plan 

The Controllers are placed under the Distribution Board folder in the Physical View. 

4. Sign on each controller within the Distribution Board. 

Sign-on includes locating the physical address of the controller on the network. 

5. Flash lamps and name the channels 

Flashing lamps locates the lamp physically on the site. Use the Auto–Flash feature on the Physical 
view to automatically flash the channels as they are being selected. 

6. Assign Load Control to fixtures by dragging physical channels from the physical view. 

Drag the physical channel from the load controller onto an existing fixture icon on the plan. The 
cursor changes to green circular arrow to indicate that the load control is to be assigned. 

Logical channels are assigned to the fixtures after they have been assigned to a physical channel. 

7. Finalize device properties and save configuration to devices. 

8. Save project 
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Sequencer 
Sequencer in EnvisionProject allows you to define a sequence of tasks. Select the Tools menu 
and select Open DyNet Sequencer to open the DyNet Sequencer Window. 

 

Dynet Sequencer 

Each sequence in the Dynet Sequencer contains a series of actions and delays. 

Sequence 
Add a sequence 

Click  Add Sequence on the DyNet Sequencer Window. 
A new sequence is displayed in the tree. 
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Sequence Properties: 

Name  
Enter a name for the sequence  

Number of Loops 
Allows the sequence to execute a given number of times or continuously. Select the type of 
loop for the sequence from the drop-down. Number of Loops can be No Loop, Continuous or 
a number. 

Action 
An Action defines a DyNet packet to be sent over the network. Action can be either a 
predefined DyNet packet or a custom DyNet packet. 

Add an Action 

Click  Add Action on the toolbar or right-click on the sequence and select Add Action from 
the context menu that is displayed. 

Action Properties 

Name 
Enter the name for the action  

Protocol 
Select the DyNet protocol.  

You can select from pre-defined action or enter the action manually. 

To enter the action manually, select Custom from the Action Type drop-down list. 

Note – The Dynet packet can be copied from the Network log and inserted into the Packet 
field by using the Insert button the toolbar. 

Delay 
A Delay can be added in a sequence to bring time delay in a sequence. Every delay in the 
sequence can have a name and time. Time delay is in the format HH:MM:ss:mm. 

Add a Delay 

  Add Delay on the toolbar or right-click on the sequence and select Add Delay from the 
context menu that is displayed. 
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Running Sequences 
A sequence can contain one or more sequences. Each sequence can have one or more actions 
and delays. 

Run a sequence, Select the sequence and click  Run. 

Stop the sequence, Select the sequence and click  Stop. 

Importing and Exporting Sequences 
• Click the Import button to import a pre-configured sequence into the current 

commissioning job. 

• Click the Export button to export sequences defined in the Dynet Sequencer to be re-
used in another commissioning job. The user has an option of exporting a single 
sequence or all the sequences in the schedule. 

• Click the Stop All button to stop the execution of sequences. 

Note – The sequences are stored in the Settings file on the PC. Hence these sequences are 
available on different jobs. To transfer the sequence to a different PC use the Export function. 
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Event Editor 
The Event Editor is used to create reoccurring events to trigger actions in a system. The Event 
Editor is accessed by selecting a Time Clock device and clicking the   edit icon on the Tasks and 
Events Page in Network View.  

Events are created in the Event Editor and stored in the memory of a Time Clock device. The 
memory in each Time Clock can hold up to 250 control tasks. 

The Event Editor works together with the Text Editor in the Time Clock to provide a graphical 
representation of a time based task. The Time Clock is pre-programmed with the local time 
zone information including sunrise, sunset and daylight savings switchover dates and times. 

 

Event Editor 

The toolbar actions for the Event Editor are the same as for the Task Editor.  

  Program an Event 

1. Click the   Add icon 

2. Enter an event name 

3. Select a time when the event will occur compared to: 
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• Absolute Time 

• Before Sunrise 

• After Sunrise 

• Before Sunset 

• After Sunset 

4. Click the required  checkboxes to select the valid Days and Months for the event 

5. Select the Date for a specific day of the month or select All. 

6. Select an action from the Action type dropdown list (pictured). 

7. Enter the required action parameters 

8. Click Test Compile check that the code written in the text  editor has no errors 

9. Click Save to job and Write to device to save the event file the EP Job file and save the 
compiled file to the device.  
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DALI Emergency Reporting 
The DALI Emergency reporting feature allows users to test emergency ballasts and report the 
status of the emergency ballasts that are present on the DALI network. This feature puts the 
emergency ballasts into a self-testing mode to confirm they operate correctly on battery power. 

The DALI Emergency Tab on the Properties Window for Network view allows the users to: 

• Manage emergency fixtures 

• Start emergency tests 

• Generate emergency test reports 

• Query emergency test results 

Alternately you can get to the DALI Emergency Tab, by clicking the Tools menu and select the 
DALI Emergency Testing. 

 

DALI Emergency tab on Properties Window 

Identifying Emergency Ballasts 
EnvisionProject automatically detects the emergency ballasts on the DALI network after a DALI 
controller enumerates the DALI ballasts. 

All emergency ballasts that are detected are initially placed under the Default Emergency Group 
in under the DALI Emergency Tab. 
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 Managing Emergency Ballasts 
The emergency ballasts are usually grouped into different groups to allow emergency ballasts 
located next to each other to be tested separately. You can add, remove and rename 
emergency ballast groups from the DALI Emergency tab. 

Creating an Emergency Group 
Click   Add Group on the DALI Emergency Tab, to add an emergency ballast group.  

Note: If there are no emergency groups then the default emergency group shall contain all the 
emergency ballasts.   

Adding an Emergency Ballast to the group 
1. Click  Add Ballast on the DALI Emergency Tab to add the emergency ballast to the 

emergency group. This displays Add Ballast To Group Window. 

2. Expand the controller tree to select the ballast and click OK 

 

Add Ballasts to a group 

The ballasts can be moved between the two groups by using  and  arrows. The ballast is 
added to the emergency group. Ballasts can also be moved between groups by dragging from 
one group to another. 
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To delete an emergency ballast or group, select the select the emergency ballast or group and 

click  

Testing Emergency Ballasts 
Emergency ballast testing can be performed on individual emergency ballasts or emergency 
ballast groups. Emergency ballasts are tested to check the ballast is operating normally under 
battery power. 

Two types of tests that can be performed on emergency ballasts are: 

• Functional Test – In this test the system is placed into emergency mode for a short 
time to see if the ballasts switch to battery power and that the battery switches the 
lights ON. 

• Duration Test - In this test the system is placed into emergency mode for a longer 
period of time to see if the ballasts switch to battery power and that the battery can 
maintain the lights ON. The Duration Test is run for a minimum of 90 minutes duration. 

Test emergency ballasts 

1. Select the emergency group that you want to test on the DALI Emergency Tab. 

2. Select the required radio buttons from the Testing group and click the Start button. 

 

Testing group on DALI Emergency tab 

3. Check the Test only previously failed ballasts to test the ballasts that failed the test 
previously. 

4. Click the Stop button to stop the test. 

5. Query Results is used to get the tests results. The reporting feature is used to view the 
test results. 
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Group Ballast Properties 
 

The group ballast properties can be used to schedule functional and duration emergency tests. 

Functional Test Time 
Schedule the date and time for the next functional test. 

Functional Test Interval (Days)  
Enter the test interval in days before the next functional test  

Duration Test Time 
Schedule the date and time for the next duration test. 

Duration Test Interval (Weeks) 
Enter the test interval in weeks before the next functional test. 

Prolong Time (Minutes) 
The time taken before switching from battery power to mains after the emergency test. 

Test Execution Timeout ( Days) 
The emergency test is terminated if the test is not completed within the Test Execution 
Timeout. 
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Reporting 
The emergency ballast test reports are displayed in the DALI Emergency Report Window.  

 

Reports section on DALI Emergency tab 

• Click the Show Report button in the Reports section to display DALI Emergency 
Report Window. 

 

DALI Emergency Report 

• Select the Ballast Group and Check the attributes in the Show Column that you want to 
display on your report and click Generate Report. 

The report is displayed in the blank space on the screen. 
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Displaying History 
The Show History button is used to view the history of test runs. Click the Show History 
button to display the DALI Emergency History Window. 

 

DALI Emergency History 

1. Select the Ballast Group or individual ballast from the drop-down list. 

2. Select the type of report  from the drop-down list: 

• All Functional and Duration History 

• All Functional History 

• All Duration History 

• Functional Results Only 

• Duration Results Only 

3. Select the Start Date and End Date. The Start Date can be Today, Last Week, Last 
Month or specified. Likewise the End Date can be selected as now or specified. 

4. Click the Generate Report button. 
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Clearing History 
The Clear History button removes the history of tests run on the project file. 

1. Click the Clear History button to display DALI Emergency History Window   

 

Clear DALI Emergency History 

2. You can select to clear all history or clear history for a period and click Clear. 

Automatic History Clean up 

You can set to clear history automatically by selecting one of the following options on the Clear 
DALI Emergency Window: 

• Never 

• Always 

• After a specific number of days 
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Area Cascading  
Area cascading is a way to configure lighting scenarios, where the lighting in one Area is 
dependent on the lighting in another Area.  

Area Cascading Functions 
Area cascading in EnvisionProject has the following functions: 

•  Corridor Linking 

•  Background Lighting 

•  Switch OFF warning 

Corridor Linking 
Corridor Linking provides an opportunity to make the light level in one area dependent on the 
occupancy state in another area. This makes it possible, for example, to keep the corridor lights 
ON if any of the adjacent rooms are still occupied. Here the corridor area acts as the parent 
area for the adjacent areas that act as the child areas. 

Background Lighting  
Background Lighting is applicable to larger areas having multiple sensors such as open plan 
offices with group of work islands. Background lighting can activate or maintain a background 
lighting level when one of the work islands’ is occupied. When the last work island in the open 
plan area goes unoccupied the lights in the open plan area switches OFF after a delay. Here the 
work islands are considered to be the child areas and the large area that accommodates the 
work islands is considered to be the parent area. 

Switch OFF warning  
Automatically dims the light levels to a certain pre-defined level when an area is unoccupied and 
then switches OFF the lights completely after a delay. When the area is vacated, the system can 
be configured to first dim the lights for a set time period to notify that the lights will soon 
switch OFF.  
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Area Cascading Editor 
You can open the Area Cascading editor by navigating to the Tools menu and clicking Area 
Cascading editor. Alternatively you can open the Area Cascading editor by selecting your job on 
the logical view and clicking the Area Cascading tab on the Properties Window. 

 

Area Cascading Editor 

The Area Cascading editor has three windows. 

1. Area Cascading Function Window – The Left side of window in the screen displayed 
above. This window allows you to add area cascading functions such as Corridor 
Linking, Background Lighting and Switch Off Warning to the areas defined in your job. 

2. Parent Area Window – The top right window in the screen displayed above. This 
window is used to set properties for the parent area  

3. Child Area Window – The bottom-right window in the screen displayed above. This 
window adds, modifies child areas and set properties for child areas.  
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Creating a Corridor Linking Area 
Follow the steps below to configure a corridor linking area. 

 

Corridor Linking  

On the Area Cascading Tab, 

1. Click Add and select  Corridor Linking from the drop-down list. 

2. In the Properties Group,  

• Enter a Name for the Corridor Linking function 

• Set Enabled as True to enable the Corridor Linking function. Set as False to disable the 
function. 

• Set Enabled at startup as True if you want to enable the function at start up. It can be 
disabled initially and enabled later by using a DyNet message 

• Enter a value for the Heartbeat timer.  

Heartbeat time is the time interval between the child areas sending a notification 
message to the parent area. The notification message consists of the current state of 
lights in the child area. Only one child Area will send the heartbeat because when other 
child Areas will reset their heartbeat timer when they see a notification message from 
another child Area 
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3. For the Corridor Area (Parent Area) 

• Select the Area for corridor linking. You can change the area by clicking change and 
selecting the area from the Area Selection dialog box displayed. 

• Select the Device (sensor) that has to be configured for corridor linking properties. 
Configured on Device is populated with the most appropriate device available in the 
area for corridor linking. 

• Set the Occupational timeout. Occupational timeout is the amount of time the parent 
Area will wait before it recalls the unoccupied preset after receiving the last notification 
message from a child Area 

• Select the Occupied preset. This is the preset of the parent area in Occupied state. 
When a notification message is received from a child Area then the parent Area will 
send this occupied preset message if the Area is not already in the Occupied preset 
state. 

• Enter the Occupied fade. The Occupied fade time is the time the parent area waits 
before sending the Occupied preset. 

• Select the Unoccupied preset. This is the preset of the parent area when the area is in 
unoccupied state. The Unoccupied preset is sent after the Occupation timeout. 

• Set Unoccupied fade. The Unoccupied fade time is the time the parent area waits 
before sending the Unoccupied preset. 

• Enter Mode Preset. This Preset can be used to start the Corridor Linking function in 
the parent Area. It is added to the list of unoccupied presets for the parent Area. 

4. For the Corridor Linking Child Area, 

• Click Add to add a child area for the corridor linking function. The Area Selection 
dialog box is displayed. 

• Select the child area from the list and click OK. 

• In the Properties group, 

Area – Displays the name of the Child Area 

Occupied Presets – Shows a list of presets for which the child area will send a 
notification to the parent area on each Heartbeat. 

Configured on Device - Configured on Device field is populated with the most 
appropriate device available in the Area. 

You can have more than one child Area configured for your parent area. 
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Delete can be used to delete a child Area. 

Modify all Areas checkbox can be checked to modify properties for all the child areas. 

You have now configured the Parent and child areas for Corridor Linking function. 
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Creating a Background Lighting Area 
Follow the steps below to configure a Background Lighting area. 

 

 

Background Lighting 

On the Area Cascading Tab, 

1. Click Add and select  Background Lighting from the drop-down list. 

2. In the Properties Group,  

• Enter a Name for the Background Lighting function 

• Set Enabled as True to enable the Background Lighting function. Set as False to disable 
the function. 

• Set Enabled at startup as True if you want to enable the function at start up. It can be 
disabled initially and enabled later by using a DyNet message 

• Enter a value for the Heartbeat timer.  

Heartbeat time is the time interval between the child areas sending a notification 
message to the parent area. The notification message consists of the current state of 
lights in the child area. Only one child Area will send the heartbeat because when other 
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child Areas will reset their heartbeat timer when they see a notification message from 
another child Area 

3. For the Open Plan Area (Parent Area) 

• Select the Area for Background Lighting. You can change the area by clicking Change 
and selecting the area from the Area Selection dialog box that is displayed. 

• Select the Device (sensor) that has to be configured for background lighting properties. 
Configured on Device is populated with the most appropriate device available in the 
area for corridor linking. 

• Enter the Occupied timeout. The Occupied fade time is the time the parent area waits 
before sending the Occupied preset. 

• Select the Standby preset. Standby preset is the preset sent after Standby fade timeout. 

• Enter the Standby fade. Standby fade is the wait time before sending the standby 
preset message. 

• Select the Unoccupied preset. This is the preset of the parent area when the area is in 
unoccupied state. The Unoccupied preset is sent after the Occupation timeout. 

• Set Unoccupied fade. The Unoccupied fade time is the time the parent area waits 
before sending the Unoccupied preset. 

• Enter Mode Preset. This Preset can be used to start the Corridor Linking function in 
the parent Area. It is added to the list of unoccupied presets for the parent Area. 

4. For the Background Lighting Work Islands (Child Area), 

• Click Add to add a child area for the corridor linking function. The Area Selection 
dialog box is displayed. 

• Select the Work Island (child area) from the list and click OK. 

• In the Properties group, 

Area – Displays the name of the Work Island (Child Area). 

Occupied Presets – Shows a list of presets for which the child area will send a 
notification to the parent area on each Heartbeat. 

Configured on Device - Configured on Device field is populated with the most 
appropriate device available in the Area. 

You can have more than one Work Island configured for your parent area. 

 Delete can be used to delete a work island (child Area). 
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Modify all Areas checkbox can be checked to modify properties for all the child areas. 

You have now configured the Parent and child areas for Background Lighting function 
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Creating a Switch Off Warning Area 
Follow the steps below to configure a Switch Off Warning Area. 

 

Switch Off Warning 

On the Area Cascading Tab, 

1. Click Add and select  Switch Off Warning from the drop-down list. 

2. In the Properties Group,  

• Enter a Name for the Switch Off Warning function 

• Set Enabled as True to enable the Switch Off Warning function. Set as False to disable 
the function. 

• Set Enabled at startup as True if you want to enable the function at start up. It can be 
disabled initially and enabled later by using a DyNet message 

• Set the Occupation timeout. Occupation timeout is the amount of time each Area 
waits before it recalls the Standby preset. 

• Enter the Standby timeout in seconds. Standby time is the amount of time that each 
Area will wait before it recalls the unoccupied preset. The Unoccupied preset is recalled 
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if the area is still in the standby preset. If the user recalls an occupied preset during the 
standby timeout (typically by triggering a motion sensor or from a keypad button) the 
then occupation timeout will be restarted. 

• Select the Standby preset. Standby preset is the preset sent after Standby timeout. 

• Enter the Standby fade. Standby fade is the wait time before sending the standby 
preset message. 

• Select the Unoccupied preset. This is the preset of the area in unoccupied state. The 
Unoccupied preset is sent after the standby timeout. 

•  Set the Unoccupied fade . Unoccupied Fade time is used when sending the 
unoccupied preset message 

• Set the Occupied presets. The list of presets for which the child area will send out the 
standby preset after the occupation timeout 

   3.  For the Switch Off Warning Child Area, 

• Click Add to add a child area for the Switch Off Warning function. The Area 
Selection dialog box is displayed. 

• Select the child Area from the list and click OK. 

• In the Properties group, 

Area – Displays the name of the Child Area. 

Occupied Presets – Shows a list of presets for which the child area will send a 
notification to the parent area on each Heartbeat. 

You can have more than one child area configured for your parent area. 

 Delete can be used to delete a work island (child Area). 

Modify all Areas checkbox can be checked to modify properties for all the child areas. 

You have now configured the Parent and child areas for Switch Off Warning function. 
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Area-Cascading Objects 
With area-cascading, different dependencies can be created between areas to perform the 
following functions: 

• Corridor Linking 

• Background Lighting 

• Switch-Off Warning 

When the area cascading functions are defined in the Area Cascading Editor the Notifier, 
Activator and Timer objects are configured on devices to perform the above functions by 
associating them with a parent and/or child area.  

Notifier Object (Child Area) 
The Notifier Object is a child object. The Notifier object sends recurring messages on to the 
DyNet network notifying its parent that it is currently occupied. Once the child area goes 
unoccupied the Notifier object stops sending messages to the parent object and this notifies the 
parent object that the child area is unoccupied. 

When the Notifier Area receives a preset message that is defined as an active preset, it will 
transmit an occupancy message to the parent Area. The Notifier’s heartbeat timer is restarted 
every time an occupancy signal is sent from the Notifier or received from another Notifier (in 
another child area) with the same parent Area.  

While the Notifier Area remains in an active preset and the heartbeat timer reaches the 
heartbeat period, it will transmit another occupancy message.  Conversely if the Notifier Area 
receives a preset message that is not in the active preset list, it will not transmit another 
occupancy message until another active preset is received. 

Activator Object (Parent Area) 
The Activator places the parent Area into an active presser when it receives an occupancy 
message from an associated Notifier.  

If the last preset message the Activator received for its own Area is in the active list and it 
receives an occupancy message for its own Area, it will transmit the Recall Preset message. 
Conversely if the last preset message the Activator receives for its own Area is not in the active 
preset list, and it receives an occupancy message it will not transmit a Recall preset message. 
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Timer Object (Parent Area) 
The Timer turns the parent Area OFF after a defined time delay when all child Areas are 
unoccupied and its own Area is in a standby preset. 

If the Timer receives a scene message for the parent Area that is in the active list or an 
occupancy message for its own Area, it will start or restart the timer. If the last preset message 
the Timer received for the parent Area is in the active list and the timer reaches the 
Occupation timeout it will transmit the Recall Preset message. Conversely if the Timer receives 
a preset message for the parent Area that is not in the Active Preset list and the timer reaches 
the Occupation timeout, it will not transmit a Recall Preset message. 
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